Model 1100 Pressurized Viscometer
with ORCADA® Software Control System

#130-81-C - With Laptop PC and Padded Carrying Case, 115-Volt
#130-81-1-C - With Laptop PC and Padded Carrying Case, 230-Volt

Instruction Manual
Updated 8/2/2016
Ver. 9.0

OFI Testing Equipment, Inc.
11302 Steeplecrest Dr. · Houston, Texas · 77065 · U.S.A.
Tele: 832.320.7300 · Fax: 713.880.9886 · www.ofite.com

©Copyright OFITE 2015
# Table of Contents

- Intro .................................................................................................. 2
- Components .......................................................................................... 2
- Features ................................................................................................... 4
- Specifications .......................................................................................... 5
- Setup ........................................................................................................ 7
  - Computer ............................................................................................ 7
  - Viscometer .......................................................................................... 8
  - System Test ........................................................................................ 9
  - Preparing for a Test ........................................................................... 11
- Software Start .......................................................................................... 12
- Calibration ................................................................................................ 16
  - Zeroing the Unit ................................................................................. 19
  - Fluid Manager .................................................................................... 20
- Operation .................................................................................................... 21
  - Manual Mode ...................................................................................... 21
  - Auto Mode ......................................................................................... 22
- Software ..................................................................................................... 23
  - Options ............................................................................................... 23
  - Save Rate Settings ............................................................................ 24
  - Test Builder ........................................................................................ 25
  - Select Analysis Outputs ................................................................... 28
  - Saved Test Data .................................................................................. 29
  - Calibration History ............................................................................ 31
  - Import/Export ..................................................................................... 32
- Disassembly ............................................................................................... 33
- Maintenance ............................................................................................. 35
  - Bob Shaft ............................................................................................ 35
  - Main Bearing Replacement ............................................................. 39
  - Rotor Nut .............................................................................................. 42
  - Fuse Replacement ............................................................................... 43
- Appendix .................................................................................................... 44
  - Diagram ............................................................................................... 44
  - Transducer Linearization ................................................................... 46
- Warranty and Return Policy ...................................................................... 49
For enhanced data collection, OFITE is pleased to introduce the new Model 1100 Pressurized Viscometer. This fully-automated system accurately determines the flow characteristics of fracturing fluids and drilling fluids in terms of shear stress, shear rate, time, and temperature at pressure up to 2500 PSI.

Using the exclusive ORCADA® software, a computer novice can operate the Model 1100, and yet the system is versatile enough for advanced research and demanding test parameters. The rugged Model 1100 is suitable for both field and laboratory use. A waterproof case with wheels makes the unit completely portable.

### Components

- **#130-75-02** Cap O-ring, -036, Viton 75D
- **#130-75-04** Thermocouple O-ring, -002, Viton 75D
- **#130-75-20** ½" Spanner Wrench
- **#130-75-27** ¼" T-handle Allen Key
- **#130-75-28** ¼" Allen Key
- **#130-75-70** Waterproof Plastic Case with Casters
- **#130-78-04** Sample Thermocouple
- **#130-78-05** Main Seal
- **#130-78-13** B1 Bob; Hastelloy with Threads for Stainless Steel
- **#130-78-17** Bob Shaft Bearing
- **#130-78-18** Bearing, Main Body
- **#130-78-20** Rotor Cup O-ring, -218, Viton 70D
- **#130-78-34** Packing Washer
- **#130-78-36** O-ring, -117, Viton 75D
- **#130-79-15** Serial Cable; OB9; M/F
- **#130-81-001** O-ring, -029, Viton 75D
- **#130-81-002** Internal Pressure O-ring, -034, Viton 75D
- **#130-81-003** O-ring, -010, Viton 70D
- **#130-81-04** Spiral Retaining Ring
- **#130-81-07** Valve Stem
- **#130-81-071** Rotor, R1 (C276), HP
- **#130-81-082** Torsion spring, 4,000 Dyne/cm²
- **#130-81-19** Bearing Retainer
- **#130-81-21** Seal Nut
- **#130-81-22** Lower Bearing
- **#130-81-27** Retaining Ring, VHM-28
- **#130-81-37** .050 Allen Key
- **#130-81-38** Seal Nut Wrench
- **#130-81-169** Shaft Assembly
- **#132-83** Calibration Fluid; 200 cP; 16 oz; Certified
- **#135-05** Spring Retaining Ring
- **#152-38** AC Power Cord; 3-Conductor International (Continental European)
- **#153-00** Bottle Brush
- **#153-55** Silicone Stopcock Grease; Dow Corning; 150g Tube
- **#153-67** 60cc Disposable Syringe
- **#170-17** Valve Stem O-ring, -008, Viton 75D
Optional:
#132-80 100 cP Calibration Fluid; 16 oz.; Certified
#130-81-084 Torsion spring, 16,000 Dyne/cm²
#132-82 500 cP Calibration Fluid; 16 oz.; Certified
#152-55 Bath/Circulator; Caron Model 2050W; Refrigerated and Heated; 115V
#152-55-1 Bath/Circulator; Caron Model 2050W; Refrigerated and Heated; 230V
#165-44 High-Temperature Thread Lubricant; 1 oz Tube
Features

- **High Pressure** - Up to 2,500 PSI (17.2 MPa)
- **High Temperature** - Up to 500°F (260°C)
- **Low Motor Shear Rates** - As low as 0.01s-1
- **Portable** - The rugged carrying case is designed for field or laboratory use and is easy to transport.
- **Small Footprint** - Only 12" x 12" (30 x 30 cm). The all-in-one design includes the heating mechanism.
- **Couette Geometry** - Uses traditional Bobs and Rotor for measurements that are easy-to-translate (shear stress range 0–4000 dynes/cm²).
- **Computer Controlled** - Using the exclusive ORCADA® software system, this viscometer is ideal for advanced research and demanding test parameters.
- **Data Acquisition** - Store your data in a text format or in a Microsoft Excel file for easy access and reporting capabilities.
- **SAFEHEAT®** - Safe, Accurate, Fast, Environmentally friendly, High Efficiency Air Transfer system. Compared to traditional oil bath heating systems, "SAFEHEAT® provides more precise control over the sample temperature without the risks of hot oil, such as spilling, splashing or flashing.
  *U.S. Patent Number 8,739,609
# Specifications

## Range of Measurement for Model 1100

<table>
<thead>
<tr>
<th>Rotor - Bob</th>
<th>R1B1</th>
<th>R1B2</th>
<th>R1B3</th>
<th>R1B4</th>
<th>R1B5</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Basic Data</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rotor Radius, RR (cm)</td>
<td>1.8415</td>
<td>1.8415</td>
<td>1.8415</td>
<td>1.8415</td>
<td>1.8415</td>
</tr>
<tr>
<td>Bob Radius, RB (cm)</td>
<td>1.7245</td>
<td>1.2276</td>
<td>0.8622</td>
<td>0.8622</td>
<td>1.5987</td>
</tr>
<tr>
<td>Bob Height, L (cm)</td>
<td>7.62</td>
<td>7.62</td>
<td>7.62</td>
<td>3.81</td>
<td>7.62</td>
</tr>
<tr>
<td>Shear Gap (cm)</td>
<td>0.117</td>
<td>0.6139</td>
<td>0.9793</td>
<td>0.9793</td>
<td>0.2428</td>
</tr>
<tr>
<td>R Ratio, RB/RR</td>
<td>0.9365</td>
<td>0.377</td>
<td>0.468</td>
<td>0.468</td>
<td>0.8503</td>
</tr>
<tr>
<td>Max Temperature (°C)</td>
<td>260</td>
<td>260</td>
<td>260</td>
<td>260</td>
<td>260</td>
</tr>
<tr>
<td>Min Temperature (°C)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

## Shear Stress Range (dyne/cm²)

<table>
<thead>
<tr>
<th>Spring, 130-81-080</th>
<th>1 - 1000</th>
<th>2 - 2000</th>
<th>4 - 4000</th>
<th>8 - 8000</th>
<th>1 - 1160</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spring, 130-81-082</td>
<td>4 - 4000</td>
<td>8 - 8000</td>
<td>16 - 16000</td>
<td>32 - 32000</td>
<td>4 - 4650</td>
</tr>
<tr>
<td>Spring, 130-81-084</td>
<td>16 - 16000</td>
<td>32 - 32000</td>
<td>64 - 64000</td>
<td>128 - 128000</td>
<td>19 - 186000</td>
</tr>
</tbody>
</table>

## Shear Rate Range*

| Shear Rate Constant (s⁻¹ / RPM) | 1.7023 | 0.3770 | 0.2682 | 0.2682 | 0.8503 |

## Shear Rate Range (s⁻¹)

### 0.01 RPM
- 0.01702
- 0.00377
- 0.00238
- 0.00238
- 0.008503

### 0.1 RPM
- 0.1702
- 0.0377
- 0.02382
- 0.02382
- 0.08503

### 1.0 RPM
- 1.702
- 0.377
- 0.2382
- 0.2382
- 0.8503

### 10 RPM
- 17.02
- 3.77
- 2.382
- 2.382
- 8.503

### 100 RPM
- 170.2
- 37.7
- 23.82
- 23.82
- 85.03

### 1000 RPM
- 1702
- 377
- 238.2
- 238.2
- 850.3

## Viscosity Range (cP)

<table>
<thead>
<tr>
<th>Minimum Viscosity with 130-81-080**</th>
<th>0.1</th>
<th>0.5</th>
<th>1.7</th>
<th>3.4</th>
<th>0.1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Viscosity with 130-81-080***</td>
<td>5,875,000</td>
<td>53,125,000</td>
<td>168,750,000</td>
<td>337,500,000</td>
<td>13,750,000</td>
</tr>
<tr>
<td>Minimum Viscosity with 130-81-082**</td>
<td>0.2</td>
<td>2.1</td>
<td>6.8</td>
<td>13.6</td>
<td>0.5</td>
</tr>
<tr>
<td>Maximum Viscosity with 130-81-082***</td>
<td>23,500,000</td>
<td>212,500,000</td>
<td>675,000,000</td>
<td>1,350,000,000</td>
<td>55,000,000</td>
</tr>
<tr>
<td>Minimum Viscosity with 130-81-084**</td>
<td>1.0</td>
<td>8.5</td>
<td>27.2</td>
<td>54.4</td>
<td>1.9</td>
</tr>
<tr>
<td>Maximum Viscosity with 130-81-084***</td>
<td>94,000,000</td>
<td>850,000,000</td>
<td>2,700,000,000</td>
<td>5,400,000,000</td>
<td>220,000,000</td>
</tr>
</tbody>
</table>

* Lower shear rates available on special order.
** At 1,000 RPM
*** At .01 RPM

When using the 130-81-079 spring use a maximum speed of 300 RPM.
<table>
<thead>
<tr>
<th><strong>Instrument Geometry</strong></th>
<th>True Couette Coaxial Cylinder</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Motor Technology</strong></td>
<td>Stepper</td>
</tr>
<tr>
<td><strong>Motor Speeds (RPM)</strong></td>
<td>Variable Speed Range .01 - 1,000</td>
</tr>
<tr>
<td><strong>Speed Accuracy (RPM)</strong></td>
<td>.001</td>
</tr>
<tr>
<td><strong>Shear Rate Range (sec⁻¹)</strong></td>
<td>.01 - 1,022</td>
</tr>
<tr>
<td><strong>Readout</strong></td>
<td>Computer Control and Data Acquisition</td>
</tr>
<tr>
<td><strong>Heat System</strong></td>
<td>300 Watt, Max Temp 500°F (260°C)</td>
</tr>
<tr>
<td><strong>Temperature Measurement</strong></td>
<td>Type &quot;J&quot; Thermocouple</td>
</tr>
<tr>
<td><strong>Automatic Tests</strong></td>
<td>API Cementing, Mud and Fracture Rheology</td>
</tr>
<tr>
<td><strong>Power Requirements</strong></td>
<td>115 or 230 Volts AC, 50/60 Hz</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>85 lbs (37.6 kg)</td>
</tr>
<tr>
<td><strong>Dimensions</strong></td>
<td>14&quot; × 13&quot; × 30&quot; (36 × 33 × 76 cm)</td>
</tr>
<tr>
<td><strong>Shipping Weight</strong></td>
<td>150 lbs (68 kg)</td>
</tr>
<tr>
<td><strong>Communication Requirements</strong></td>
<td>RS-232 Serial Port or LAN or Bluetooth.</td>
</tr>
<tr>
<td><strong>Operating System</strong></td>
<td>Windows 2000, XP or higher.</td>
</tr>
</tbody>
</table>

### Viscosity Conversions

To convert from units on left side to units on top, multiply by factor @ intercept.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Centipoise (cP)</th>
<th>Poise (P)</th>
<th>g/(cm × s)</th>
<th>(mN × s)m²</th>
<th>mPa × s</th>
<th>(lb × s) / 100 ft²</th>
</tr>
</thead>
<tbody>
<tr>
<td>Centipoise</td>
<td>1</td>
<td>0.01</td>
<td>0.01</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0.002088</td>
</tr>
<tr>
<td>Poise</td>
<td>100</td>
<td>1</td>
<td>1</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>0.2088</td>
</tr>
<tr>
<td>g/(cm × s)</td>
<td>100</td>
<td>1</td>
<td>1</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>0.2088</td>
</tr>
<tr>
<td>(mN × s)m²</td>
<td>1</td>
<td>0.01</td>
<td>0.01</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0.002088</td>
</tr>
<tr>
<td>mPa × s</td>
<td>1</td>
<td>0.01</td>
<td>0.01</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0.002088</td>
</tr>
<tr>
<td>lb × s / 100 ft²</td>
<td>478.93</td>
<td>4.789</td>
<td>4.789</td>
<td>478.93</td>
<td>478.93</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

### Shear Stress Conversions

To convert from units on left side to units on top, multiply by factor @ intercept.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Dyne/cm²</th>
<th>Pa</th>
<th>lb/100 ft²</th>
<th>lb/ft²</th>
<th>DR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dyne/cm²</td>
<td>1</td>
<td>0.1</td>
<td>0.2084</td>
<td>0.002084</td>
<td>0.1957</td>
<td></td>
</tr>
<tr>
<td>Pa</td>
<td>10</td>
<td>1</td>
<td>2.084</td>
<td>0.02084</td>
<td>1.957</td>
<td></td>
</tr>
<tr>
<td>lb/100 ft²</td>
<td>4.788</td>
<td>0.4788</td>
<td>1</td>
<td>0.01</td>
<td>0.939</td>
<td></td>
</tr>
<tr>
<td>lb/ft²</td>
<td>478.8</td>
<td>47.88</td>
<td>100</td>
<td>1</td>
<td>93.9</td>
<td></td>
</tr>
<tr>
<td>DR</td>
<td>5.107</td>
<td>0.5107</td>
<td>1.065</td>
<td>0.01065</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>
1. First, check that the computer’s AC power setting matches the available power in your region. This switch is typically found on the upper back panel of the computer and will be either 115V or 230V.

2. Connect the monitor, mouse, and keyboard to the computer and connect the monitor and computer to an AC power outlet. The computer and monitor were shipped with the appropriate power cords.

   If your Model 1100 was supplied with a laptop computer instead of a desktop model, simply open the laptop and turn the power on. The AC power cord can be used to prevent the battery from draining completely during operation. Remember to periodically charge the battery by leaving the AC power cord plugged in overnight.

3. Turn the monitor and computer on. After the computer has booted up completely, check for the ORCADA® icon on the desktop.
Setup

Viscometer

1. On the back panel, locate the three ¼” (6.35mm) NPT fittings. Connect a water source (15 - 30 PSI / 104 - 208 kPa), Nitrogen source, and drain hose to the appropriate fittings.

   The Nitrogen is used to pressurize the sample and prevent boiling at temperatures above 212°F (100°C). The water is used to raise and lower the heater.

2. Screw the heater cable from the heat bath into the bottom of the cabinet.

3. Plug the thermocouple from the heat bath into the bottom of the cabinet.

4. Connect the viscometer to the computer using either a 9-pin RS232 cable, a Local Area Network connection with an Ethernet cable, or Bluetooth.

5. Make sure the “Power” switch is in the off position. Plug the power cord into an AC power source.
1. Turn the unit on. The power switch is located on the front panel.

2. If the heater is raised, lower it using the “Heater Lift/Lower” switch.

   The sample cup is already attached to the viscometer in order to protect the bob shaft during shipping. Always handle the bob shaft carefully; bending it will result in poor viscosity readings.

3. To remove the sample cup, unscrew the sample cup nut and pull the sample cup straight down.

4. Carefully apply a thin coating of high-temperature thread lubricant (#165-44) to the bob shaft threads.

5. To install the bob, slide it onto the bob shaft with the tapered end down and screw it securely into place. An R1B1 bob/rotor combination is standard for the Model 1100 Viscometer, however other combinations are available. See page 5 for more information.
6. Turn on the computer and open the ORCADA® software (see page 12 for instructions).

7. From the menu bar at the top of the screen, select “Utilities” and then “Calibrate Shear Stress”. Check the “Temperature” field to verify that it shows room temperature. Then, confirm that the value in the “Shear Stress Raw” fluctuates when you gently turn the bob with your hand.

If either of these values does not display as expected, make sure the Model 1100 is turned on and that all cables are securely connected. If the problem is still not corrected, return to the “Main Screen” in the ORCADA® software and choose “Edits” and then “Options”. In the “COM Port” drop-down menu, choose a different port and try again. See page 23 for information about the “Options” screen.

8. It is recommended that a Calibration procedure be run due to the possibility of mishandling during shipment. Refer to the “Calibration” section on page 16 for detailed instructions on calibrating the unit.
Setup
Preparing for a Test

1. Install the bob as described in steps 1 - 6 on page 9.

2. Fill the sample cup with the proper amount of fluid based on the bob you are using. Refer to the chart below.

<table>
<thead>
<tr>
<th>Body Type</th>
<th>B1</th>
<th>B2</th>
<th>B3</th>
<th>B4</th>
<th>B5</th>
<th>XB1</th>
<th>XB2</th>
<th>XB5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Amount (mL)</td>
<td>42</td>
<td>78</td>
<td>96</td>
<td>104</td>
<td>52</td>
<td>32</td>
<td>73</td>
<td>44</td>
</tr>
</tbody>
</table>

3. Hold the sample cup by hand and position the bob in the center. Push the sample cup up past the o-ring. Hold the sample cup in place and screw the sample cup nut into place.

4. Position the heat bath under the sample cup and raise it. The bath can be raised either manually and secured with the supplied pin or automatically with the “Heater Lift / Lower” switch. Press the button to release.

5. To pressurize the sample, gradually rotate the regulator knob clockwise. To reduce pressure, gradually rotate the regulator knob counterclockwise at a rate no greater than 60 PSI per minute.

Pressure is only necessary for tests temperatures above 200°F (95°C). The heaters will be deactivated if the sample is not pressurized enough to prevent boiling. The ORCADA® software will indicate this with a yellow alarm light. The alarm light will turn green when the appropriate pressure is applied to the sample. Refer to the chart below for the minimum pressure requirements.

6. Once the pressure is set and the heater is in place, the Model 1100 is ready to run a test.

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Pressure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ambient - 200°F (Ambient - 93.3°C)</td>
<td>0 PSI (0 kPa)</td>
</tr>
<tr>
<td>201° - 295°F (93.9° - 146.1°C)</td>
<td>100 PSI (690 kPa)</td>
</tr>
<tr>
<td>296° - 355°F (146.7° - 179.6°C)</td>
<td>200 PSI (1,380 kPa)</td>
</tr>
<tr>
<td>356° - 395°F (180.1° - 201.8°C)</td>
<td>300 PSI (2,070 kPa)</td>
</tr>
<tr>
<td>396° - 445°F (202.4° - 229.6°C)</td>
<td>500 PSI (3,450 kPa)</td>
</tr>
<tr>
<td>446° - 500°F (230.2° - 260.2°C)</td>
<td>800 PSI (5,520 kPa)</td>
</tr>
</tbody>
</table>
Software Start

1. Double-click the “ORCADA®” icon on the desktop.

2. The first time you run the software, you will be asked to select a hardware configuration. Select “Model 1100 v2” and click “OK”. You will now see the Main Screen.

3. The Windows XP firewall may try to block the ORCADA® software from communicating with the viscometer. If the firewall shows the following alert, select “Unblock”.

![Windows XP Firewall Alert](image)

**Main Screen**

- **Available Tests**
- **Log Indicator**
- **Status**
- **Communication Indicator**
- **Bath Control**
- **Key**
- **Manual Mode Controls**
- **Analysis Data**
- **Process Variables**

**“Start Test”** - This button starts a test in Auto Mode. Once a test is started, this button becomes the “Abort Test” button. Click here to stop the test.

**“Cement”** - This button performs a standard cement test based on API specifications.

**“Mud”** - This button performs a standard mud test based on API Specifications.
Note: When running the “Mud” and “Cement” tests, the values for “Dead Time” and “DAQ Time” on the Options screen should be ignored. Temperature and pressure control, which are disabled during custom Auto-Mode tests, are available during a “Mud” or “Cement” test.

“Progress” - This button opens the Test Progress window, which shows all of the steps of the current test and highlights the one currently in process.

“Status” - This box at the top of the screen shows the current status of the test.

“Comm Timeout” - This light will be off when the PC is successfully communicating with the viscometer. If communication is interrupted for any reason, the light will shine red to indicate a problem.

“Start Logging” - This button is available in manual mode only. Click here to begin recording test data. The light next to this button will shine green while logging is in progress.

“Cond Pause” - This button will pause a test during the conditioning phase and put the software into Manual Mode. While the test is paused, the motor and heat controls can be controlled in the same manner as in a standard Manual Mode test.

To resume the test, click the “Cond Pause” button again. You will be asked if you want to “Continue” the test with the remaining conditioning time or if you want to “Override” the remaining time and extend the effective conditioning time. If you choose to “Continue”, the time remaining in the conditioning cycle will appear as though the test was never paused. If you choose to “Override”, the time remaining in the conditioning cycle will resume at the point where the test was paused.
For example, assume a test has a conditioning time of 10 minutes and the test is paused at the 5 minute mark for 1 minute. If the test is unpause using the “Continue” option, the time remaining in the conditioning cycle will be 4 minutes. However, if the test is unpause using the “Override” option, the time remaining in the conditioning cycle will be five minutes, making the effective total conditioning time 11 minutes.

“Raw File Save Period” - This field determines how often data is recorded during a test.

“Experiment Name” - This field will be used to identify the experiment later. This field is required before starting a test in Auto Mode or starting logging in Manual Mode.

“Bob” - Select the type of bob currently being used in the unit. An incorrect value in this field will adversely affect your test results.

“Key” - The checkboxes next to the graph key enable and disable graphing of the indicated values. For example, to exclude RPM from the graph, uncheck the “RPM” box. You can also customize the appearance of the lines on the graph by clicking on the line example on the right side of the key.

“Manual Mode Controls” - The manual mode controls, in the bottom left-hand corner of the screen, adjust the rotor speed and the temperature while the unit is operating in manual mode.

“Rotation” - This field determines the rotational speed. The drop-down box beneath the field set the units to either RPM or 1/s.

“Enable” - Place a check in this box to engage the motor. Uncheck the box to stop the motor.

“Temp” - This field determines the test temperature. The drop-down list beneath the field sets the units to either °F or °C.

“Enable” - Place a check in this box to enable temperature control. If the value in the “Temp” field is higher than the sample temperature, the heaters will engage to heat the sample.

“PreHeat” - The software will not heat a sample above 200°F (93°C) unless the sample is pressurized. The preheat button allows the software to heat the bath to higher temperatures without giving a low pressure warning. Enter a value in the “Temp” field and check the “PreHeat” box to preheat the bath prior to heating the sample.
“Cool” - Place a check in this box to activate the cooling solenoid and begin cooling the sample. The value in the “Temp” field must be lower than the sample for the software to initiate cooling.

“Clear” - This button removes all data from the graph.

“Analysis Model” - This field, below the graph, displays the current Analysis Model being used in the test. This variable is set in the Test Builder (refer to page 25 for more information).

“Analysis Data” - This chart shows the calculated values based on the Analysis Model being used for the test. This data will not display until after the analysis sweep is completed.

“Temperature”, “Shear Stress”, “Viscosity”, “Shear Rate”, “RPM” - These fields display the current value for these variables. They are display only. The drop-down box next to the “Shear Stress” field changes the units of the Shear Stress variable. The units can be set to: Dyne/cm², lb/100ft², Pa., Dial Reading, lb/ft²
Calibration

The ORCADA® calibration program should be run before performing the first test. Additional calibration is recommended when:

1. The bob is changed.
2. The unit has been sitting unused for several days.
3. The unit has been serviced (i.e. bearings changed).
4. If the “r^2” value displayed in the analysis model is below .99 during a sweep.
5. Every two weeks during normal operation.

According to API Recommended Practice 10B-2, viscometers being used for testing well cement should be calibrated quarterly. API Recommended Practice 13B-1 and 13B-2 specify viscometers being used for drilling fluids should be checked monthly.

The calibration fluid should be stored at room temperature and away from direct sunlight. The shelf life of the calibration fluid is 2 years. The calibration fluid used during the calibration program should be checked for suspended solids and clarity prior to being poured back into the bottle for storage. Cloudy calibration fluid should be disposed of properly.

1. Prepare the viscometer for a test as described on page 8.
2. Open the ORCADA® software. From the menu bar select “Utilities” and then “Calibrate Shear Stress”.
3. Observe the “Shear Stress Raw” value. Before performing any tests or calibrations, record this value (while the unit is at 0 RPM) here: ____ If this value drifts more than 2 or 3 units during the life of the machine, you must zero the transducer. Refer to page 19 for instructions.
4. Select a calibration fluid from the “Cal Fluid Batch” drop-down list. If the list is empty, click the “Fluid Manager” button to add new fluid batches. Refer to page 20 for instructions.

If the “Temp Out of Range” light shines red, the current sample temperature is out of the specified range for the calibration fluid. The sample will have to be heated or cooled to be within the acceptable range before calibration.

Do not attempt a calibration if the sample is not within the appropriate temperature range.

When using the 130-81-079 spring, use 200 cP fluid with a B5 bob and 100 cP fluid with a B1 bob.
5. Choose a set of calibration rates from the “Rate Set” drop-down list.

To create or edit a rate set, click the “Calibration Rates” button. To create a new set, click the “New” button and enter a name and the rotational speeds. To edit a set, select it in the “Rate Set” list, then change the rotational speeds as necessary.

Calibrating at speeds above 300 RPM can adversely affect results. All speeds in your rate set should be greater than 0 and less than or equal to 300.

6. Click the “Start Calibration” button to begin the calibration.

Once the calibration has started, the software will begin filling in the chart and plotting the results on the graph.

7. As the calibration proceeds, the software will begin to display the collected data in the chart. At the end of the calibration, the software will calculate the “r^2C” value, which measures the accuracy of the calibration. If this value is less than 0.9990, recalibrate the unit. If this value is still low, change the bob shaft bearings (see page 35 for instructions) and try the calibration again. If the Model 1100 still does not calibrate, the unit will require servicing by an OFITE technician.

8. When the calibration is complete, check the r^2C value to make sure it is greater than .9990. If it is, click the “OK” button and enter a title for the calibration.
“S.S. Reference” - the shear stress as calculated by the software

“S.S. Raw” - the actual signal coming from the unit

“RPM” - rotational speed

“Viscosity Reference” - the viscosity of the sample as calculated by the software

“Temp” - the temperature of the sample

“S.S. Best Fit” - shear stress value for a perfect calibration

“Viscosity Best Fit” - viscosity value for a perfect calibration

“S.S. Fit Error” - deviation of actual shear stress from “S.S. Best Fit”

“r^2” - This is a measure of the accuracy of the calibration. It will be calculated at the end of the calibration cycle. If this value does not read greater than 0.9990 after multiple calibration tests, the unit will require servicing.

“r^2C” - The r^2 value only provides useful information when a calibration is performed on a linear scale. For non-linear scales, the r^2C shows the corrected r^2 value and will provide a better measure of the accuracy of the calibration. For linear scales, the r^2 and r^2C values will be the same.

“Temperature” - the temperature of the sample

“Shear Rate” - rotational speed (1/s)

“RPM” - rotational speed (RPM)

“Shear Stress Raw” - the actual signal coming from the unit

“Ref Viscosity” - the viscosity of the sample as calculated by the software

“Ref Shear Stress” - the shear stress as calculated by the software
When calibrating the Model 1100, the “Shear Stress Raw” value on the calibration screen should display the value you recorded before the first calibration on page 16. If the signal reading is not within 2 or 3 units of this number, the transducer will need to be reset to zero.

To zero the unit for calibration you must adjust the position of the transducer cap.

1. Bleed off all pressure from the system. Remove the top panel by loosening the four quarter-turn locks on each corner.

2. Loosen, but do not remove, the thermocouple compression fitting from the top of the transducer cap.

Be very careful to keep the thermocouple straight. A bent thermocouple will cause inaccurate readings.

3. Loosen the eight set screws with the ½” (1.59 mm) Allen wrench provided.

4. Observe the “Shear Stress Raw” value on the “Calibrate Shear Stress” screen in the ORCADA® software.

5. Slowly rotate the transducer cap until the “Shear Stress Raw” value reaches the desired range. The sensor is very sensitive, so only very slight adjustments are required. Allow a few seconds for the signal to stabilize between adjustments.

6. Once the signal is within range, tighten the setscrews on the transducer cap. Observe the signal value after 15 seconds to make sure the signal does not drift out of range.

7. Tighten the thermocouple compression fitting.
Before calibrating the unit, you must input the specifications of the calibration fluid that you are using. This will give the software the information it needs to perform the calibration accurately.

Click the “Fluid Manager” button on the Calibration screen to add a new calibration fluid batch.

1. Click “New” to add a new batch. You can also edit an existing batch by selecting it in the “Batch Selector” list.

2. In the “Batch” field, type a name for the batch. OFITE recommends using the lot number and viscosity from the Certification Chart that was provided with the fluid.

3. In the “Calibration Fluid Table”, enter at least two Temperature/Viscosity pairs from the Certification Chart. Only two pairs are required.

   The “Table Linearity Error” light will shine red if the values in the “Calibration Fluid Table” do not create a straight line. If this occurs, check the values and re-enter them.

4. Once you have entered all the batches, click “OK” to close the Fluid Manager and return to the Calibration screen.
To begin a test in **Manual** mode:

1. Prepare the viscometer for a test. Refer to page 8 for instructions.

2. Choose the shear stress units from the drop-down box next to the “Shear Stress” field. Your choices are: Dyne/cm², lb/100ft², Pa., Dial Readings, and lb/ft².

3. Enter a value in the “Rotation” field and choose a setting for units (RPM or 1/s).

4. Select the “Enable” checkbox next to the “Rotation” field to start the motor.

   Once the motor is started, the display fields on the right-hand side of the screen will begin displaying test data.

5. Enter a temperature in the “Temp” field and choose Celsius or Fahrenheit.

6. Select the “Enable” checkbox next to the “Temp” field to start the heater.

   Here, checking the “Enable” and “PreHeat” button allows you to pre-heat the bath to the desired temperature without applying any initial heat to the sample. When the bath has reached the temperature set point, raise the bath to begin heating the sample.

   **Important**
   
   **Remember, if your test will exceed 200°F (93°C), apply the recommended pressure based on the chart on page 11.**

7. Enter a name in the “Experiment Name” field and click the “Start Logging” button.

   This field will be used to identify the experiment later.

8. Enter a comment in the resulting dialog box. Comments are optional, but can be used later to identify the test results.

9. To stop the test, click the “Stop Logging” button and uncheck the “Enable” checkboxes.

10. Disassemble and clean the unit (refer to page 33 for instructions).

   **Important**

   **Allow the sample temperature to drop below 120°F (49°C) before reducing the pressure. Make sure the pressure reads 0 before removing the sample cup.**
To begin a test in **Auto** mode:

1. Prepare the viscometer for a test. Refer to page 8 for instructions.
2. Choose a test to run from the list in the upper left-hand corner of the Main Screen.
   
   If no tests are listed, create a new one in the “Test Builder”. Refer to page 25 for instructions.
3. Enter a name in the “Experiment Name” field.
4. Set the shear stress units using the drop-down menu next to the “Shear Stress” field.
5. Click the “Start Test” button.
6. Enter a comment in the resulting dialog box. Comments are optional, but can be used later to identify the test results.
7. Disassemble and clean the unit (refer to page 33 for instructions).

**Important**

*Allow the sample temperature to drop below 120°F (49°C) before reducing the pressure. Make sure the pressure reads 0 before removing the sample cup.*
To access the Options screen, choose “Options” from the “Edit” menu.

“Enable Bath Level Control” - If this box is checked, the “Raise Bath” button on the “Main Screen” will be visible and active.

“RPM DAQ Settings” - “RPM High”, “RPM Med” and “RPM Low”, “Dead Time”, “DAQ Time”. These fields are used to determine the amount of time needed for the sample to stabilize at a given rate. The fields are also used to determine the amount of time data is averaged before being saved. For example, if RPM High is set to 60, Dead Time is set to 15 and DAQ Time is set to 20, any rate of 60 RPM or greater during a sweep would stabilize for 15 seconds then begin averaging data for 20 seconds before saving the data.

“Reverse Rates Gel UI” - If “Hysteresis” is selected on the “Test Builder” screen (see page 25), this option will perform a gel test after the forward portion of the sweep and after the backward portion.

“Data Archive Directory” - Specify the directory to store archived data.

“Logo Files” - Specify a logo file (.jpg format) to display on the graph at the end of the test.

“Time Format” - Choose a time format for all of the ORCADA® software.
Software

Save Rate Settings

By default, the ORCADA® Software saves data to file based on a set time interval. This time interval can be changed by editing the “Raw File Save Period” field on the main screen. However, the “Save Rate Settings” feature provides more control over data save points. The software will monitor each selected variable and record a data point to the file when that variable changes by the amount specified.

1. Select “Save Rate Settings” from the “Edit” menu.

2. Place a check mark next to each variable you wish to monitor.

3. In the field after the variable name, enter the variance required to initiate a save point.

   For example, if you want the software to record a data point when the temperature increases or decreases more than 5°, place a check next to “Temperature” and enter 5 in the field next to it.

4. Click “OK” to save the settings and return to the main screen.

“Elapsed Time” - seconds since the start of the test

“RPM” - rotational speed (RPM)

“Shear Rate” - rotational speed (1/s)

“RPM SP” - rotational speed setpoint

“Temperature” - measured sample temperature

“Temperature Bath” - measured temperature of the oil bath

“Temperature pH” - Not available on the Model 1100.

“Temp SP” - temperature setpoint

“Temp Duty Cycle” - the frequency (in seconds) the heaters engage to increase the temperature

“Viscosity” - measured viscosity (cP)

“Shear Stress” - measured shear stress

“Shear Stress Tare” - change in measured shear stress

“Pressure” - measured pressure

“Pressure SP” - pressure setpoint

“pH” - Not available on the Model 1100.
The Test Builder is designed to help you build custom tests for use in Auto mode. To access the test builder, go to the Main Screen and choose “Test Builder” from the “Edit” menu.

1. To create a new test, click the “New Test” button. To create a new test based on one of the “RP 10B”, “RP 13D”, or “RP 39” analysis models, click the appropriate button at the top of the screen to open a template. To edit an existing test, select the test from the list in the upper left-hand corner of the screen.

2. Enter a name in the “Test Name” field.

3. Choose an Analysis Model.
   a. “RP 39” - Power Law Model - records the Power Law calculations (n and k)
   b. “RP 13D” - Bingham Plastic Analysis Models - records plastic viscosity (PV) and yield point (YP)
   c. “RP 10B” - Power Law and Bingham Plastic Models combined

4. Input the values for your test into the fields in Record 1.
   a. “Heat Time” - the time it will take the unit to heat the sample to the temperature setpoint. If this field is left blank, the unit will heat the sample as fast as possible.
   b. “Heat RPM” - the rotational speed during the heating period
   c. “Temp” - the temperature setpoint. Enter any letter in this field to indicate “Ambient”.

![Available Tests](image1)

![Records](image2)

![Test Detail](image3)
d. “Cond. Time” - the time period to condition the sample

e. “Cond. RPM” - the rotational speed during conditioning

f. “#/Swps” - the number of sweeps to perform after conditioning. A sweep is a set of rotational speeds separated by time interval. Between sweeps, the rotor returns to the Cond. RPM. At the end of each sweep, the unit calculates the Analysis Model values.

g. “Delta Time” - the time interval between sweeps

h. “Gel Time 1” - During a gel time interval, the rotor comes to a complete stop and waits. At the end of the interval, the rotational speed is increased to 3 RPM until the gel breaks and a gel strength value is recorded. Click the “Insert Gel Column” button to add a gel time to the record.

i. “RPM 1, 2, 3” - The RPM fields set the speed of each step of the sweep.

5. Click the “OK” button to save the test and return to the main screen.

“Hold for Temp” - Click this checkbox to tell the unit to wait until the sample has reached the temperature setpoint before proceeding to the next step. If this box is unchecked, the test will proceed while the sample is heating.

“Temp Threshold” - This field specifies an acceptable variance on the temperature. For example, if the temperature setpoint is 150° and the “Temp Threshold” is set to 5°, the unit will consider the setpoint reached when the temperature is between 145° and 155°.

“Temp Unit” - set temperature units to either °F or °C

“Rate Unit” - set the rate units to either RPM or 1/s

“Pressure Unit” - set the pressure units to either PSI or kPa

“Hysteresis” - If this box is checked, each sweep will be performed forward and backwards.

“Stir Parameters” - These parameters only apply if the test includes a gel time.

“Stir Prior to Gel” - Check this box to stir the sample before calculating gel strength.
“Gel Stir Rate” - This is the rate the sample will be stirred prior to calculating gel strength.

“Gel Stir Time” - This is the time interval the sample will be stirred.

“Plot All Records” - If this box is checked, all records will be plotted on the graph. If it is not checked, only the currently highlighted record will be plotted.

The graph below the records provides a visual representation of the current test. Each line represents one aspect of the test: RPM Setpoint, Temperature Setpoint, Pressure Setpoint, and Temperature PV. Refer to the key to the right of the graph for details.

The graph features a cursor, a vertical yellow line, that can be used to view more detailed information about the different phases of the test. The “Center Cursor” button moves the cursor to the center of the graph. Click and drag the cursor across the graph to see more detailed information. Refer to the “Test Detail” field below the graph for more information.
After building a test in the Test Builder, the chart at the bottom of the main screen will show the various data points being calculated by the viscometer based on the chosen analysis model. This chart, however, is customizable. You can choose which data points are displayed on the chart and which are not.

From the “Edit” menu, choose “Select Analysis Outputs”. By default, all data points are selected and will appear on the chart. To remove a data point from the chart, simply uncheck the box next to it.
Software

Saved Test Data

To review test data from past tests:

1. Select “Saved Test Data” from the “File” menu.

2. The saved test data is grouped by month. Select the folder for the year and month of the data you are looking for and click the small + sign next to it. This will show you all of the data for tests run that month, including any comments you added.

3. Select the test you are looking for and click the “OK” button. Multiple tests can be selected by holding down the CTRL key and selecting each test.

4. On the “Raw Data” tab you will see the graph of the test results. The “Analyzed Data” tab shows the results of the calculations based on the Analysis Model. The “Test Setup” tab shows the parameters of the test.
“Export” - Click this button if you wish to export the test data to a file. You will be asked to select a filename and destination and then click “OK”. The resulting file can then be opened in Microsoft® Excel for further analysis.

“Print” - Click this button to print the results to the default printer.

“Experiment Explorer” - Click this button to choose another set of test data to review.

“OK” - Click this button to return to the main screen.
On the Calibration History Screen, you can retrieve the data from all past calibration tests.

1. Begin on the Main Screen. Select “Calibration History” from the “Utilities” menu.

2. The calibration tests are grouped by month. Select the folder for the year and month of the calibration test you are looking for and click the small + sign next to it. This will show you all of the calibration tests run that month, including the fluid batch and any comments you added after the test.

3. Select the test you wish to view and click the “OK” button.

4. You can now see the graph, chart, and fluid batch details.

5. Click the “Export” button if you wish to export the calibration results to a file. You will be asked to select a filename and destination and then click “OK”.

6. When you are finished reviewing the calibration history, click the “OK” button to return to the main screen.
The Import/Export feature of the ORCADA® Software makes it possible to transfer a test from one PC to another.

1. Begin on the Main Screen. Choose “Export” from the “File” menu.

2. Select the tests you wish to export. Hold down the CTRL key to select multiple tests.

3. Click the “Export” button. You will be asked to choose a destination and filename and then click “OK”.

4. Copy this file to the destination PC.

The file must be placed in the correct folder for it to be available for import. To find this folder, first navigate to the folder specified in the “Data Archive Directory” field in the Options screen (see page 23 for details). From there go to the “ORCADA®” folder and then the “Tests Import Export” folder.

5. On the destination PC, choose “Import” from the “File” menu.

6. Choose the tests you wish to import. Hold down the CTRL key to select multiple tests.

The “Export” field lists all of the files that are available for import. Once you have selected one, the “Tests” field shows which individual tests can be imported from that file.

Below the “Export” and “Tests” fields is a display-only field that shows the folder being scanned for exported tests. Make sure the tests you want to import have been placed in that folder.

7. Click the “Import” button. The new tests will appear in the list in the upper left-hand corner of the Main Screen.
Disassembly

This procedure should be performed immediately after every test.

1. Lower the heat bath.

2. Allow sample to cool to below 120°F (48.9°C).

3. Gradually decrease the pressure at a rate of 30 - 60 PSI (200 - 400 kPa) per minute.

4. Slowly open the valve stem at the bottom of the sample cup (see photo on page 9). This will relieve any remaining pressure from the cup. Keep a container underneath the valve stem to collect any sample fluid that leaks.

5. Unscrew the sample cup nut and pull the sample cup straight down. Hold it directly under the bob to catch any residual fluid that may be dripping.

6. Gently turn the bob counterclockwise to remove it from the bob shaft.

    Be very careful to keep the thermocouple straight. A bent thermocouple will cause inaccurate readings. Pull the bob straight down slowly.

7. Unplug the power supply.

8. Open the panel on the right-hand side of the unit cabinet.

9. Inside the cabinet, locate one of the six holes on the rotor tube.
10. Insert a wrench, screwdriver or other long, rigid item into the hole to hold the rotor tube in place.

11. While holding the rotor tube in place, unscrew the expansion joint and remove it from the machine.

12. Clean all removed parts with water. Wipe any residual fluid from inside the rotor with a folded paper towel.

13. Reinstall each of the removed parts.

Note: Remember to hold the rotor tube in place while tightening the expansion joint.
Before performing any type of maintenance, be sure and unplug the power supply and bleed off all Nitrogen. Also, be careful not to bend the bob shaft and thermocouple.

When working with bearings, be careful not to handle them with your bare hands. The oil from your skin can contaminate the bearing.

A good indicator that maintenance is required is if the $r^2C$ value is less than .9990 (refer to page 18 for more information). If a calibration check using certified calibration fluid shows viscosity readings that are not linear at multiple shear rates, this can also indicate a problem that requires maintenance.

1. Unplug the viscometer from the electrical source.
2. Gently turn the bob counterclockwise to remove it from the bob shaft.
   
   Be very careful to keep the thermocouple straight. A bent thermocouple will cause inaccurate readings. Pull the bob straight down slowly.

3. Unscrew the expansion joint.
   
   Remember to hold the rotor tube in place as described in steps 8 - 11 on page 33.

4. Remove the top panel.
5. Unplug the thermocouple and the grey cable that runs into the top of the transducer cap.
6. Unscrew the eight allen bolts from the transducer cap. Be careful not to drop the Allen bolts into the viscometer. Remove the transducer cap and set it aside.

   Be very careful to keep the thermocouple straight. A bent thermocouple will cause inaccurate readings.
7. Unscrew the eight allen bolts that hold the transducer body to the main body. Remove the transducer body. It may be necessary to loosen the o-ring seal by gently rocking the transducer body back and forth.

8. Loosen the set screw on the torsion spring.

9. With the split ring pliers, remove the retaining ring just below the bearing retainer.

10. Slide the lower bearing and bearing retainer off the bob shaft.

11. Slide the bob shaft up out of the transducer body.
12. At this point, the torsion spring is fully accessible in case it needs to be changed. To change the torsion spring:

   a. Turn the transducer body upside down.

   b. Unscrew the hex screws on the spring retainer.

   c. Remove the spring retainer and torsion spring.

   d. Insert a new torsion spring into the depression in the transducer body.

   e. Slide the spring retainer over the torsion spring and secure it in place with the hex screws.

13. Slide the upper bearing off the bob shaft.

14. Slide a new bearing onto the bob shaft.

   **Important**

   **Do not touch the new bearings with your bare hands. Oils from your skin can damage it.**

15. Slide the bob shaft back into the transducer body.

16. Slide a new bearing onto the bottom of the bob shaft. Slide a bearing retainer onto the shaft beneath the bearing.

17. Using the split ring pliers, place the retaining ring below the bearing retainer to hold it in place.

18. With the transducer body upside down, turn the bob shaft clockwise until it stops. Then turn the bob shaft back slightly and tighten the set screw on the torsion spring to secure it to the bob shaft.
19. Inspect the o-ring on the torsion body and replace it if necessary. Apply a light coating of silicone grease around the o-ring.

20. Lower the transducer body back into the main body.

   Make sure the stop pin on the head of the bob shaft is aligned toward the front of the viscometer.

21. Lubricate the Allen bolt threads with a thin coating of high-temperature thread lubricant (#165-44). Screw the eight Allen bolts back into place on the transducer body. Tighten the bolts in a crisscross pattern.

22. Place the transducer cap back on top of the transducer body.

23. Lubricate the Allen bolt threads with a thin coating of high-temperature thread lubricant (#165-44). Screw the eight Allen bolts back into place on the transducer cap. Tighten the bolts in a crisscross pattern.

24. Plug in the thermocouple and transducer.

25. Turn the unit on and adjust the transducer cap.

26. Re-calibrate the unit before performing another test.
Maintenance

Main Bearing Replacement

1. Remove the transducer body as described in steps 1 - 7 on page 35.

2. Loosen the Allen bolts at the bottom of the motor. Slide the motor forward just enough to loosen the belt and remove it from the rotor.

3. Remove the rotor cap nut. Pull the rotor assembly straight down to remove it from the main body.

   To avoid damaging the o-ring inside the seal nut, turn the rotor gear counterclockwise while pulling downward gently.

4. Remove the main bearing from the main body and replace it with a new one.

   Do not touch the new bearings with your bare hands. Oils from your skin can damage it.
5. With the supplied seal nut wrench, remove the brass seal nut from beneath the main body.

6. The main seal is seated inside the top of the seal nut. Inspect this seal and replace it if it shows signs of damage or wear.

7. Apply a thin coat of grease to the entire surface of the seal. Make sure the grease fills the gap between the seal and the seal nut.

8. The lower bearing sits inside the bottom of the seal nut. Inspect this bearing and replace it if it shows signs of damage or wear.

   The lower bearing is pressed into the seal nut and cannot be removed without destroying it. Do not attempt to remove the lower bearing unless it is already damaged and not usable.

   **Important**

   Do not touch the new bearings with your bare hands. Oils from your skin can damage it.
9. Once the bearings and seals have been replaced, screw the seal nut back into the main body. Use the spanner wrench or seal nut wrench to tighten it.

10. Insert the rotor back into the main body from below.

   To avoid damaging the o-ring inside the seal nut, turn the rotor gear clockwise while pushing upward gently.

11. Once the threads on the top of the rotor tube are visible above the main bearing, screw the rotor cap nut onto the rotor tube.

   **Important**
   
   **After removing the rotor cap nut, you must apply Loctite (#130-81-090) to the threads before reinstalling it. Without Loctite, the rotor cap nut could loosen and cause the rotor tube to fall.**

12. Wrap the chain around the rotor and pull the motor back to tighten it. Tighten the Allen bolts on the motor to secure it in place.

13. Reassemble the head assembly as described in step 19 - 26 on page 38.
Maintenance

Rotor Nut

The rotor tube is held in place by a threaded nut at the top. If this nut becomes loose, the rotor tube will shake during operation and could damage other components.

The rotor, expansion joint, and rotor tube should all be firmly attached to the viscometer. If you detect any back and forth movement of these parts, it will be necessary to tighten the rotor nut.

1. Remove the transducer body. Follow the instructions in steps 1 - 7 on page 35.

   The rotor nut screws onto the top of the rotor tube. It will be visible after you remove the transducer body.

2. Hold the rotor tube in place to keep it from falling. Unscrew the rotor nut.

3. Apply a few drops of Loctite (#130-81-090) to the threads on the rotor nut.

4. Put the rotor tube back in place and secure it with the rotor nut. Make sure the nut is tight.

5. Reassemble the head assembly as described in step 19 - 26 on page 38.
Maintenance
Fuse Replacement

There are two fuses that control the power supply. They are located in a small compartment by the power switch. Simply use a small screwdriver to pry open the compartment and replace as needed. Use two 3-amp fuses.

Additional fuses are located inside the cabinet. To replace these fuses:

1. Open the back cabinet by loosening the two quarter-turn locks.

2. You will see 5 fuses on the inside of the back panel. The black fuses pop out and the gray ones flip up.

The power supply may hold an electrical charge. Be very careful not to touch it while changing the fuses.

<table>
<thead>
<tr>
<th>Label</th>
<th>Component</th>
<th>Fuse (115V)</th>
<th>Fuse (230V)</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Heater</td>
<td>2 amp</td>
<td>2 amp</td>
</tr>
<tr>
<td>F2</td>
<td>Motor</td>
<td>2 amp</td>
<td>2 amp</td>
</tr>
<tr>
<td>F3</td>
<td>Main Power Supply</td>
<td>1 amp</td>
<td>1 amp</td>
</tr>
<tr>
<td>F4</td>
<td>SSR - Heater</td>
<td>3 amp</td>
<td>3 amp</td>
</tr>
<tr>
<td>F5</td>
<td>SSR - Ram</td>
<td>3 amp</td>
<td>3 amp</td>
</tr>
</tbody>
</table>
Refer to the next page for a list of parts that correspond to the labels on this diagram.
The parts listed below correspond to the labels on the diagram on the previous page.

<table>
<thead>
<tr>
<th>#</th>
<th>OFITE Part #</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>130-81-12</td>
<td>Main Body</td>
</tr>
<tr>
<td>2</td>
<td>130-78-36</td>
<td>O-ring; Viton; #117</td>
</tr>
<tr>
<td>3</td>
<td>130-81-001</td>
<td>O-ring; Viton; #029</td>
</tr>
<tr>
<td>4</td>
<td>130-81-22</td>
<td>Lower Bearing</td>
</tr>
<tr>
<td>5</td>
<td>130-81-21</td>
<td>Seal Nut</td>
</tr>
<tr>
<td>6</td>
<td>130-78-05</td>
<td>Main Seal</td>
</tr>
<tr>
<td>7</td>
<td>130-81-27</td>
<td>Hex Socket Head Cap Screw; ¼-28 × 1&quot;</td>
</tr>
<tr>
<td>8</td>
<td>130-81-04</td>
<td>Retaining Ring; Spiral</td>
</tr>
<tr>
<td>9</td>
<td>130-78-18</td>
<td>Main Bearing</td>
</tr>
<tr>
<td>10</td>
<td>130-81-14</td>
<td>Rotor Tube</td>
</tr>
<tr>
<td>11</td>
<td>130-78-42</td>
<td>Spiral Retaining Ring</td>
</tr>
<tr>
<td>12</td>
<td>130-78-30H</td>
<td>Expansion Joint; C276</td>
</tr>
<tr>
<td>13</td>
<td>130-78-34</td>
<td>Packing Washer</td>
</tr>
<tr>
<td>14</td>
<td>130-78-20</td>
<td>Rotor Cup O-ring; Viton; #218</td>
</tr>
<tr>
<td>15</td>
<td>130-81-05</td>
<td>Guard Washer</td>
</tr>
<tr>
<td>16</td>
<td>130-75-02</td>
<td>Cap O-ring; Viton; #036</td>
</tr>
<tr>
<td>17</td>
<td>130-81-15</td>
<td>Transducer Body</td>
</tr>
<tr>
<td>18</td>
<td>130-75-75</td>
<td>Standoff</td>
</tr>
<tr>
<td>19</td>
<td>130-81-082</td>
<td>Torsion spring, 4,000 Dyne/cm²</td>
</tr>
<tr>
<td>20</td>
<td>130-78-22</td>
<td>¼&quot; × ⅛&quot; Stop Pin</td>
</tr>
<tr>
<td>21</td>
<td>130-78-17</td>
<td>Bob Shaft Bearing</td>
</tr>
<tr>
<td>22</td>
<td>130-81-11</td>
<td>Guide Tube</td>
</tr>
<tr>
<td>23</td>
<td>130-75-461</td>
<td>Coil Retainer</td>
</tr>
<tr>
<td>24</td>
<td>130-75-79</td>
<td>Hex Socket Head Cap Screw; 8-32</td>
</tr>
<tr>
<td>25</td>
<td>130-75-78</td>
<td>Hex Socket Flat Head Cap Screw; 8-32</td>
</tr>
<tr>
<td>26</td>
<td>135-05</td>
<td>Bushing</td>
</tr>
<tr>
<td>27</td>
<td>130-81-19</td>
<td>Bearing Retainer</td>
</tr>
<tr>
<td>28</td>
<td>130-78-07</td>
<td>B1 Bob</td>
</tr>
<tr>
<td>29</td>
<td>130-77-069</td>
<td>Nitrogen Port; SS Swagelok Tube Fitting; Male Connector; ⅝&quot; Tube OD × ⅛&quot; Male NPT</td>
</tr>
<tr>
<td>30</td>
<td>130-81-160</td>
<td>Bob Shaft Assembly</td>
</tr>
<tr>
<td>31</td>
<td>130-81-18</td>
<td>Transducer Clamp</td>
</tr>
<tr>
<td>32</td>
<td>130-81-02</td>
<td>Transducer</td>
</tr>
<tr>
<td>33</td>
<td>130-75-76</td>
<td>Sensor Retainer Set Screw; #6-32 × .125</td>
</tr>
<tr>
<td>34</td>
<td>130-81-007</td>
<td>Thermocouple Compression Fitting; SS-1-UT-1-2BT</td>
</tr>
<tr>
<td>35</td>
<td>130-81-17</td>
<td>Transducer Cap</td>
</tr>
<tr>
<td>36</td>
<td>130-81-002</td>
<td>O-ring; Viton; #034</td>
</tr>
<tr>
<td>37</td>
<td>130-81-060</td>
<td>R1 Rotor Assembly</td>
</tr>
<tr>
<td>38</td>
<td>142-54</td>
<td>O-ring for Valve Stem Port</td>
</tr>
<tr>
<td>39</td>
<td>170-17</td>
<td>O-ring for Valve Stem</td>
</tr>
</tbody>
</table>
The transducer linearization process is only necessary if the transducer board or the universal board have been replaced.

1. Make sure the computer is connected to the Model 1100 viscometer and that the ORCADA® software is not open. Remove the rotor cup so that the bob is exposed.

2. Open Hyperterminal. In the “New Connection” dialog box, give the connection a name. This name is unimportant. However, it is necessary to enter something in the “Name” field.

3. Set the following port settings:
   - Bits per second: 38400
   - Data bits: 8
   - Parity: None
   - Stop bits: 1
   - Flow control: None
4. Click OK to connect to the viscometer.

5. Press the Enter key twice to bring up the prompt.

6. Turn the bob counterclockwise and hold it against the stop.

7. On the computer type C and press Enter.

8. Ignore the instruction on the screen. Slowly turn the bob clockwise until it reaches the other stop.

9. Type N and press Enter. The software will show details of the calibration. Close Hyperterminal.
10. Fill the rotor cup with 200 cP calibration fluid and place it on the rotor.

11. Open the TransCal software supplied by OFITE.

12. On the “Manage Devices” screen, right-click the Viscometer in the list and select “Default Device”. Then click “Done”.

   If the Viscometer does not appear in the list, select the correct COM port from the list and click the “Search for Devices” box.

13. Click the “Start Transducer Calibration” button. The transducer calibration will run automatically for about 20 minutes. At the end of the procedure, the status screen will disappear. Close the TransCal software and open the ORCADA® software.

14. Calibrate the viscometer through the ORCADA® software before running any other tests.
Warranty and Return Policy

Warranty:
OFI Testing Equipment, Inc. (OFITE) warrants that the products shall be free from liens and defects in title, and shall conform in all respects to the terms of the sales order and the specifications applicable to the products. All products shall be furnished subject to OFITE’s standard manufacturing variations and practices. Unless the warranty period is otherwise extended in writing, the following warranty shall apply: if, at any time prior to twelve (12) months from the date of invoice, the products, or any part thereof, do not conform to these warranties or to the specifications applicable thereto, and OFITE is so notified in writing upon discovery, OFITE shall promptly repair or replace the defective products. Notwithstanding the foregoing, OFITE’s warranty obligations shall not extend to any use by the buyer of the products in conditions more severe than OFITE’s recommendations, nor to any defects which were visually observable by the buyer but which are not promptly brought to OFITE’s attention.

In the event that the buyer has purchased installation and commissioning services on applicable products, the above warranty shall extend for an additional period of twelve (12) months from the date of the original warranty expiration for such products.

In the event that OFITE is requested to provide customized research and development for the buyer, OFITE shall use its best efforts but makes no guarantees to the buyer that any products will be provided.

OFITE makes no other warranties or guarantees to the buyer, either express or implied, and the warranties provided in this clause shall be exclusive of any other warranties including ANY IMPLIED OR STATUTORY WARRANTIES OF FITNESS FOR PURPOSE, MERCHANTABILITY, AND OTHER STATUTORY REMEDIES WHICH ARE WAIVED.

This limited warranty does not cover any losses or damages that occur as a result of:
- Improper installation or maintenance of the products
- Misuse
- Neglect
- Adjustment by non-authorized sources
- Improper environment
- Excessive or inadequate heating or air conditioning or electrical power failures, surges, or other irregularities
- Equipment, products, or material not manufactured by OFITE
- Firmware or hardware that have been modified or altered by a third party
- Consumable parts (bearings, accessories, etc.)

Returns and Repairs:
Items being returned must be carefully packaged to prevent damage in shipment and insured against possible damage or loss. OFITE will not be responsible for equipment damaged due to insufficient packaging.

Any non-defective items returned to OFITE within ninety (90) days of invoice are subject to a 15% restocking fee. Items returned must be received by OFITE in original condition for it to be accepted. Reagents and special order items will not be accepted for return or refund.

OFITE employs experienced personnel to service and repair equipment manufactured by us, as well as other companies. To help expedite the repair process, please include a repair form with all equipment sent to OFITE for repair. Be sure to include your name, company name, phone number, e-mail address, detailed description of work to be done, purchase order number, and a shipping address for returning the equipment. All repairs performed as “repair as needed” are subject to the ninety (90) day limited warranty. All “Certified Repairs” are subject to the twelve (12) month limited warranty.

Returns and potential warranty repairs require a Return Material Authorization (RMA) number. An RMA form is available from your sales or service representative.

Please ship all equipment (with the RMA number for returns or warranty repairs) to the following address:

**OFITE Testing Equipment, Inc.**
**Attn: Repair Department**
**11302 Steeplecrest Dr.**
**Houston, TX 77065**
**USA**

OFITE also offers competitive service contracts for repairing and/or maintaining your lab equipment, including equipment from other manufacturers. For more information about our technical support and repair services, please contact techservice@ofite.com.